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Summary

This application note demonstrates the creation of a basic MicroBlaze™ processor based
system for a Kintex™-7 FPGA made using Vivado™ IP integrator. The system can be used to
run any operating system. This application note demonstrates porting a free RTOS operating
system. This system includes native Xilinx® IPs such as Timer, MicroBlaze processor, AXI
block RAM, double data rate (DDR), UARTLite, MicroBlaze Debug Module (MDM),
proc_sys_reset, and local memory bus (LMB). These are the basic building blocks of any
system.

In addition to creating the system described above, this application note also discusses porting
an operating system on a Kintex device that uses Xilinx Software Development Kit (SDK) in the
Vivado design suite. It prints "hello world" in an OS thread.

The reference system is targeted for the Xilinx KC705 FPGA evaluation board.

Introduction

This design was created using the 2012.4 version of Vivado Design Suite. Versions prior to
2012.4 require a license to use IP integrator.

To test your system on a KC705 board, you must use a terminal emulation program such as
TeraTerm/hyperterminal. You must also ensure that the device drivers for the board are
correctly installed.

Figure 1 shows the layout of a KC705 board with a Kintex-7 FPGA.
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Figure 1: KC705 Board Layout
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Table 1: Reference System Address Map

Peripheral Version Instance Base Address High Address
MicroBlaze 8.40.b microblaze_1 N/A N/A
Axi_timer 1.03.a axi_timer_1 0x41c00000 0x41cOffff
Axi_uartlite 1.02.a axi_uartlite_1 0x40600000 0x4060ffff
Axi_INTC 2.00.a axi_intc_1 0x41200000 0x4120ffff
LMB_BRAM_con | 1.00 mb_bram_if_cntr_1 | 0x00000000 0x00001fff
troller
mig_7_series 1.7 mig_7_series_1 0x80000000 Oxffffffff
AXl4 Interface 2.00.a axi_vdma_0 0xc0000000 0xc0000fff
BRAM controller

Hardware Requirements

Xilinx Kintex-7 KC705 board
One USB (Type A to Type B)
JTAG platform USB cable
Power cable to the board

Software Requirements

Vivado Design Suite 2012.4
SDK14.4

The following hardware and software are required for this reference system.

Requirements
Hardware

System .
Specifics .

The hardware design includes:

MicroBlaze processor

MicroBlaze Debug Module (MDM)
Local Memory Bus (LMB) block RAM
AXI4_INTERCONNECT

Mig DDR3 RAM
AXI_BRAM_Interface_controller
PROC_SYS_RESET

AXI_TIMER

AXI_UARTLITE

AXI_INTC

The MicroBlaze processor acts as controller for other devices and runs the operating system
(OS) to prioritize and schedule various tasks. This is a basic system that can be used to build
a more complex system on top of this. The IP added in this system are such that they are
important for any embedded application and will go a long way in helping you focus only on your
IP; you need not worry about the connection or interface of these low-level IP.
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Hardware Reference System

AXI4 Interconnect

The design documented in this application note contains two AXI4 Interconnects. One is used
for accessing memory through the cache, and the other is used for accessing peripherals. For
more information, see the LogiCORE IP AXI Interconnect Data Sheet [Ref 1].

* The AXI_Interconnect_1 is used as a bridge between the MicroBlaze processor
Instruction cache and Data cache to write into the AXlI4 BRAM and the DDR3SDRAM.
This Interconnect makes the ICache and DCache buses the master to write into a
connected slave memory.

e The AXI_interconnect_2 is used to connect the axi_timer, axi_uartlite, and axi_intc to the
MicroBlaze processor AXI Data peripheral bus.

MIG 7 Series

The Memory Interconnect Generator (MIG) is designed to generate DDR3SDRAM to be used
in the system. This includes setting the clock frequency, period and type, the data width used,
and the DDR pin constraints. The mig_7_series, once re-configured as DDR3 SDRAM, drives
the clock in this system and is the slave of the Instruction cache and Data cache buses of the
MicroBlaze processor. The 114 pins of the DDR interface are mapped to a interface port and

the local constraints of these pins are specified manually by importing a user defined constraint
file.

Hardware A working system is provided with this document. All necessary external configuration files can
Reference be found in this system. The path of these files, wherever used in this document, is specified.
System Any reference to the path of this system is referred to as <reference design path>.

The reference design has been fully verified and tested on the Kintex-7 FPGA KC705 board.
The reference design files for this application note are provided in xapp1162 . zip, which is
available as an addition to this document. You can download it from
https://secure.xilinx.com/webreg/clickthrough.do?cid=201113.

The reference design checklist is shown in Table 2.

Table 2: Reference Design Checklist

Parameter

Description

General

Developer name

Dinesh Kumar, Yashovardhan Bhatt

Target devices (stepping level, ES,
production, speed grades)

Kintex 7 (KC705) FPGA

Source code provided

Yes

Source code format

VHDL/Verilog (some sources encrypted)

Implementation

Synthesis software tools/version used

Vivado Design Suite 2012.4

Implementation software tools/versions
used

Vivado Design Suite 2012.4

Hardware Verification

Hardware verified

Y

Hardware platform used for verification

KC705 board
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Creating a New Project

1. Open the Vivado integrated design environment (IDE).
2. In the Welcome window, click Create New Project.

VVADO i

Getting Started Documentation

Create New Project
Mew Project wizard will guide you through the process

\ of selecting design sources and a farget device for
N a new project,

o Open Project ) User Guide

»
\ ‘ Open one of the most recently used projects or J/ More detailed info on Yivado commands, ©
\ Sl any previously created project, "\_. and buttons.

m Open Example Project AN Quick Take Videos
‘!’ﬁ
I

Open one of the tutarial projects Further assistance adopting Vivada flows

e Documentation and Tutorials

Invaluable for first time users or to try naw

Figure 2: Creating New Project

The New Project wizard opens.
3. Click Next.
4. Type the project name and location.

Caution! Do not use spaces in the project name or location name.
5. Click Next.

New Project

Project Name
Enter a name for your project and specify a directory where the project data files will be stored “1

" Froject name: - | project_1 |

Create project subdirectory

Project will be created at: ., pi_embedded_example 032 fproject_1

| <Back || Newt > | | cancel

Figure 3: Naming Your Project

6. Select the Create Project Subdirectory check box.
7. Click Next.
For this project, do not add any sources.
8. Select your target language. For this project, select Verilog.
9. Click Next.
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10.

11.
12.
13.
14.

~

New Project

Add Sources
Specify HOL and netlist files, or directories containing HOL and netlist files, to add 1o vour project. Create a new

source file on disk and add it to your project. You can also add and create sources later,

x

]Id IName [Library ]HDL Source for ILocation ]
5 |
1|
]
| addFies. | | AddDirectories.. | | creaeFile...

[JScan and add RTL include files into project

[#] Copy sources into project

[ Add sources from subdirectories

Target Languag
——

| < Back | Mext > ||

| [ cancel

Figure 4: Selecting Verilog as Target Language

For this project, do not add IPs.

Click Next.

For this project, do not add constraints.

Click Next.

Click Boards.

Select the Kintex-7 KC705 Evaluation Platform.
Click Next.

Default Part

Choose a default Xilink part ar board far vour praject. This can be changed later.

Specify Filter
| @ Parts Farmily |4l -
Package |All e
Speed grade [All d

Reset All Fllters

4]

search; [ |
- i R T
i 5 Bwvaluation Flatform| G xc7k3251Mg900-2 900 500 203800 407600 4
LB Ao =TS ¥ P AT S L T [EEL ) B0V A00 1030
LA | 3 (=]

| < Back ]| st | | cancal

Figure 5: Selecting Kintex-7 KC705 Board

15. Click Next.

The project summary displays.

16. Click Finish to create your project.
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Creating a New Block Diagram
In this section, you will create a new project.

Click the Create Block Design option in the IP Integrator tab of the Flow Navigator.
2. Type a name for the design.
3. Click OK.

A3 e p X | b X | @ K| E (|23 peraur Layour - |R|®
Flow Nawigator « Project Manager - project_L
QT Sources — O % || T project summary x
Tt B E -]
4 Project Manager il % | I [E] 5 @ Project Settings Edit §
ls0 Design Sources [ ]
& Project Settings 4 Constraits (1 Froject name: project_1
(¥ Add Sources -1 Simulation Sourees (1) Product family: Kint
LF IP Catalog —a sim. 1 Froject part

Top module name:  ho

1P Integrate. ST ———
& Create Block Design P synthesis

Status. = Ready
Part XC7K225tffg900-2

Simulation
@4 simulation Setting:
(il Run simulation

Hierarchy | Libraries Compile Order

£ Sources ¥ Templates [ Create Block Design

Properies 9 Please specify name of block design

2[5

) open static simulation

N

RTL Analysis
[a* Open Elaboratect Design

Design name:  [Hesign_1 ]

Synthesis it hasn't been run
&) synthesis Senings ok J[ cancel |

# Run Synthesis
B Gpen Synihes

Implementation
p Tel Consale
@ Settings =y

dproject project_1 /proi/ips/users/vashova/IP_Integrator/basic_sys_d9a/project_1 -part xc7k325tffg900-2
[» Run Implememation

.

et_property board k705 [current_project]

Program and Debug
@ Bitstream Settings
¥, Generate Bitstream
B open Hardware Session
B Lo

X & @ i §

3y

(T 10 Q‘Icl(nnsnln) Messages  Gllog |4 Reports | % Dasign Runs

Figure 6: Creating a New Project
The Tcl Console displays the equivalent Tcl commands for each action.
Adding IP
First, add the MicroBlaze processor IP.

1. Right-click in the block diagram window and select Add IP.

2. Inthe IP catalog that opens, type microblaze in the search bar and press the Enter key.
You can also add multiple IPs by dragging them from the catalog to the block diagram.

The IP is added to the diagram. The IP integrator allows you to change the position of an IP in
the diagram: horizontally in rigid vertical columns and vertically in a column.

Next, add the following IPs, shown in Figure 7:

* MIG 7 Series Memory Interface Generator
* MicroBlaze Debug Module
e Proc Sys Reset
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mdm_1
S proc_sys_reset_1
MBDEBUG_O-{]—"I
Slowest_sync_clk MB_Reset
Interrupt
Debug_5Ys_Rst - Ext_Reset_In Bus_Struct_Reset[0:0]
e Alx_Reset_ln Peripheral_Reset[0:0]
MB_Debug_Sys_REst  Interconnect_aresetn[0:0]
Dem_locked Peripheral_aresetn[0:0]
mig_7series_1 microblaze 1
sy5_I'st |I[ 4= INTERRUPT
clk_ref_p init_calib_complete |||+ DEBUG DLMEHk |||
clk_ref_n Clk ILMe < |||
Reset

Figure 7: Add MicroBlaze processor, MDM, MIG 7 Series, and Proc System Reset IPs
Navigating the Block Diagram

The main window of IP integrator has a toolbar on the left. Figure 8 displays descriptions of the
toolbar buttons.

':’l | —> Block Diagram Options - here you can choose to see/hide connections and customize the colors of the block diagram.
Ak —> ZoomIn | Ctrl + = | drag mouse in southwest direction in the block diagram.
'C'i; —> Zoom Out | Ctrl +- | drag mouse in northeast direction in the block diagram

"yl — Zoom Fit | Ctrl + O | drag mouse in northwest direction in the block diagram

[\., —> Select Area drag around an area (southeast drag) to zoom into that area

I'I':k —> Fit Selection | F9 | Zoom-to-fit selected objects

'L‘.:, —> Auto Fit Selection (toggle on/off) - automatically zoom-to-fit selected objects
L — addwr

1::( —> Customize IP

@j —> Regenerate Diagram

Figure 8: P Integrator Toolbar Description
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Customizing DDR

Do the following to use the Xilinx Memory Interface Generator to customize the double data rate
(DDR):

1. Double-click the mig_7_series to customize the mig_7_series (DDR3) IP.
The Memory Interface Generator opens.

Xilinx Memory Interface Gene|

Memory Interface Generator

REFERENCE
DESIGN [1] The Memory Interface Generator (MIG) creates memory controllers for Xilinx FPGAs. MIG creates complete customized
Verilog or VHDL RTL source code, pin-out and design censtraints for the FPGA selected, and script files for implementation
and simulation.
Vivada Project Options
This GUI includes all configurable options along with explanations to aid in generation of the required controller. Please note
that some of the options selected in the Vivado Project Options will be used in generation of the controller. It is very
important that the correct Vivado Project Options are selected. These options are listed below.
selected Vivade Project Options
FPGA Family Kintex-7
M FPGA Part xc7k325t-ffga00
emory Speed Grade 5
Synthesis Tool VIVADO
Design Enti VERILOG
Interface Bl
If any of these options incorrect, please click on "Cancel", change the Vivado Project Options, and
restart MIG. This versi: f MIG is guaranteed to work with ISE 14.4 and Vivado 2012.4, not tested with other
Generator ISE versions or Vivado versions.

& XILINX.

| user Guide | | version info

Figure 9: Memory Interface Generator

2. Click Next.
By default, the create design option is enabled and the number of controllers is set to 1.
3. Select the AXI4 Interface check box to enable the AXI4 Interface.

Xilinx Memory Interface Generator
REFERENCE
skt MIG Output Options.
@ Create Design
Select this option to generate a memery controller. Generating a memory controller will create RTL. design constraints (UCF),
implementation and simulation files.
Verify Pin Changes and Update Design

Selecting this feature verifies the modified UCF for a design already generated through MIG. This option will allow you to chan
the pin out and validate it instantly It updates the input UCF file to be compatible with the current version of MIG. While updatir
UCF it preserves the pin outs of the input UCF. This option will also generate the new design with the Component Name you
selected in this page

Component Name:

Please specify the component name for the memory interface. The design directories will be generated under a directory wit
name. Three directories will be created "example_design”."user_design” and "docs". The user_design will contain the genera
memory interface. The example_design adds a simple example applicati to the memory interface.

Compenent |
1 _mig 7series_1 (
Name SR =2

Memory

Multi-Controller

Up to maximum of 8 controllers with a combination of DDR3 SDRAM. QDRI+ SRAM or RLDRAM Il can be generated. The numbe
Interface controllers that can be accommodated may be limited by the data width and the number of banks available in device. Refer us
quide for more information

Number of Controllers |1 |
Generator -

AXI4 Interface

AX|4 interface is supported only for DDR3 SDRAM and DDR2 SDRAM controllers with Verilog desigr

& XILINX. - :

User Guide | [Version Info | <Back Cancel

Figure 10: Enable the AXI4 Interface
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4. Click Next.

Do not select pin compatible FPGAs.

REFERENCE
oesion [1]

Memory Selection

Memory Options

FPGA Options

Extended FPGA Options
10 Planning Options
Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

| user Guide | | version info |

£ XILINX.

Xilinx Memory Interface Generator

Pin Compatible FPGAs

Pin Compatible FPGAs include all devices with the same package and speed grade as the target device, Different FPGA
devices with the same package do not have the same bonded pins. By selecting Pin Compatible FPGAs, MIG will only select
pins that are common between the target device and all selected devices, Use the default UCF in the par folder for the target
part If the target part is changed, use the appropriate UCF in the compatible_ucf folder If a Pin Compatible FPGA is not
chosen now and later a different FPGA is used, the generated UCF may not work for the new device and a
board spin may be required. MIG only ensures that MIG generated pin out is compatible among the selected compatible
FPGA devices. Unselected devices will not be considered for compatibility during the pin allocation process.

A blank fist indicates that there are no compatible parts exist for the selected target part and this page can be skipped
Note that different parts in the same package will have different internal package skew values. De-rate the minimum period
appropriately in the Controller Options page when different parts in the same package are used. Consult the User Guide for
more information

Target FPGA | xc 7k

Pin Compatible FPGAs
= kintex7
= Tk

Xxc7k410t-fg800

< Back Xt Cancel

5. Click Next.

Figure 11:

Pin Compatible FPGA Options

DDR3 SDRAM is selected by default.

REFERENCE
pesio (1]

Pin Compatible FPGAs ¥

Controller Options

AXI Parameter

Memory Options

FPGA Options

Extended FPGA Options
10 Planning Options
Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

& XILINX.

| User Guide | | Version Infa |

Xilinx Memory Interface Generator =@
Memory Selection
Select the type of memory interface. Please refer to the User Guide for a detailed list of supported controllers for each FPGA
family. The list below shows currently available interface(s) for the specific FPGA, speed grade and design entry chosen

Select the Controller Type:

@ DDR3 SDRAM
DDR2 SDRAM

< Back Cancel

6. Click Next.

Figure 12: Memory Selection Options
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REFERENCE
oEsiGH [1]

Pin Compatible FPGAs ¥
Memory Selection v

AXI Parameter

Memory Options

FPGA Options

Extended FPGA Options
10 Planning Options

Pin Selection

System Signals Selection
Summary

Simulation Options

PCB Information

Design Notes

| user Guide | | version Info |

Options for Controller 0 - DDR3 SDRAM

Clock Period: Choose the clock period for the desired frequency The allowed perig
range(1072 - 3300) is a function of the selected FPGA part and FPGA speed grade
Refer to the User Guide for more information

The allowed period range is PRELIMINARY. The final range will be listed after cha

400.00 MHz

tion.

PHY to Controller Clock Ratio: Select the PHY to Memory Controller clock ratio. The PHY operates =
at the Memory Clock Period chosen above. The controller operates at either 1/4 or 1/2 of the PHY a1 s
rate. The selected Memory Clock Period will limit the choices

Vecaux_jo: Vccaux_io must be set to 2.0V in the High Performance banks for the highest

data rates. Vecaux_io is not available in the High Range banks. Note that Vecaux_io is
common to groups of banks. Consult the 7 Series Datasheets and FPGA Selectlo

Resources User Guide for more information.

Memory Type: Select the memory type. Typel(s) marked with a warning symbol are g
compatible with the frequency selection above.

Memory Part: Select the memory part. Part(s) marked with a warning symbol are not
compatible with the frequency selection above. Find an equivalent part or create a part
using the “Create Custom Part* button if the part needed is not listed here. The “Create ‘
Custom Part” feature is not supported for RLDRAM Il

Memory Voltage: Select the Voltage of the Memory part selected 15V

Data Width: Select the Data Width. Parts marked with a warning symbel are not
compatible with the frequency and memory part selected above-

ECC: MIG supports ECC for 72 bit data width configuration. To be able to select ECC,
select a data width that has ECC supported.

[MTeTF12864HZ-166 3 |

Create Custom Part

Data Mask: Enable or disable the generation of Data Mask (DM) pins using this check
box. This option can be selectable only if the memory part selected has DM pins.
Uncheck this box to not use data masks and save FPGA I/Os that are used for DM signals.
ECC designs (DDR3 SDRAM, DDR2 SDRAM) will not use Data Mask.

ORDERING Normal mode allows the memory controller to reorder to the

memory to obtain the highest possible efficiency Strict mode forces the controller to
execute commands in the exact order received

v
( XI I I NX Memory Details: 1GB, x8, row:14, col:10, bank 3, unbuffered, data bits per strobe-8, with data mask, single rank, 1.5V
®

Normal s

=< Back

Cancel

Figure 13: Controller Options

MT*JTF12864HZ-1G6.

9. Click Next.

Set the value of the clock period to 2500 ps (400.00 MHz)
Select the memory type as SODIMMSs. This changes the Memory Part to

REFERENCE
pesian [1]

Pin Compatible FPGAs ¥~
Memory Selection v
Controller Options v

Memary Options

FPGA Options

Extended FPGA Options
10 Planning Options
Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

AXI Parameter Options CO - DDR3_SDRAM

Data Width:AXI DATA WIDTH: Data width of AXI read & write channels. The data width is less than or
equal to user interface data width with the possible values 32, 64, 128, 256 & 512

address channels

scheme between the read and write RD_PRI_REG P ‘

Narrow Burst Support: Enables logic to support narrow bursts on the AXi4 slave interface. Can be set to
zero if no masters in the system issue narrow bursts and all the data widths are equal (1-Enable, 0- 13

Disable)

Address Width: Ax14 address width of read and write address channels. The address width is always
fixed to 32 bits. The most significant bits when memory col address + row address + bank addressis 32
lesser than 32-bits wide will be ignored by the controller

ID Width: AXI4 ID width for read and write channels. AXI4 ID is used as the identification tag for write or
read address group of signals

& XILINX.

| User Guide | | version Info |

< Back

Cancel

10. Set Data Width to 32.

Figure 14:

11. Set Data ID Width to 4.

AXI Parameter Options
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12. Click Next.

REFERENCE
oesioH (11

Pin Compatible FPGAs ¥~
Memory Selection v
Controller Options v

AXI Parameter v

FPGA Options

Extended FPGA Options
10 Planning Options
Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

& XILINX.

User Guide | | Version Info |

linx Memory Interface Generator alx

Memory Options for Controller 0 - DDR3 SDRAM

Input Clock Period: Select the period for the PLL input clock (CLKIN). MIG
determines the allowable input clock periods based on the Memory Clock Period
entered above and the clocking guidelines listed in the User Guide. The g
design will use the selected Input Clock and Memory Clock Periods to generate the
requirad PLL parameters. If the required input clock period is not available, the
Memory Clock Period must be modified.

Choose the Memory Options for the memary device. Memory Option selections are restricted to those supported by
the controller. Consult the memory vendor data sheet for more information.

Read Burst Type and Length
The burst type determines the data ordering within a burst. Consult the memory datasheet for

more information. Burst length 8 is the only supported value sequential %]
Output Driver impedance Control

Programmable impedance for the output buffer. RZQ/7 il
Controller Chip Select Pin

T Gl et { Gl pie s wiy i Emel bttt L ey v o gt it s el

group when this selection is set to 'Disable’. Disable is only valid for single rank Enable 0|

configurations

RTT (nominal) - On Die Termination (ODT)
Select the nominal value of ODT for the DQ, DQS/DQS# and DM signals on the component or

DIMM interface. This must be set to RZQ/6 i(40 ohms) for data rates at 1333 Mbps and abor

In 2 slot DIMM configuations this value will be used for the unwritten slot during a write an
also be used for the unselected slot during a read. Use board level simulation to choose the

optimum value

Memory Address Mapping Selection
ress

LTS
ROW BANK COLUMN

e [eank | ROW [ cowmn |

T Gancel

Figure 15: Memory Options

13. Set the Input Clock Period to 5000 ps (200 MHz).
14. Set nominal value of the On Die Termination to RZQ/6.
15. Click Next.

REFERENCE
DESIGN [

Pin Compatible FPGAs ¥
Memory Selection v
Controller Options

AXI P,

\ 4
meter v
Memory Options v

FPGA Options
10 Planning Options
Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

System Clock
Choose the desired input clock configuration. Design clock can be Differential or Single-Ended

System Clock Differential <

Reference Clock

Choose the desired reference clock configuration. Reference clo

rerential or Single-Ended

Reference Clock Use System Clock

Debug Signals Control

This feature allows various debug signals present in the IP to be monitored on the ChipScope tool. The debug signals include
status signals of various PHY calibration stages. Enabling this feature will connact all the debug signals to the ChipScope ILA
and VIO cores in the example design top module. A part of each bus in the debug interface has been grounded so that users
can replace the grounded signals with the required signals

Debug Signals for Memory Controller OFF =)

This selects the value of Sample Data depth for Chipscope ILA used in Debug logic
Sample Data Depth 10

Internal Vref

internal Vref can be used to allow the use of the Vref pins as normal 10 pins. This option can only be used at 800 Mbps and
lower data rates. This can free 2 pins per bank where inputs are used. This setting has no effect on banks with only outputs

Internal vref
10 Power Reduction

significantly reduces average 10 power by automatically disabling DQ/DQS IBUFs and internal terminations during WRITES and
periods of inactivity

10 Power Reduction ON bl

XADC Instantiation

The memory interface uses the temperature reading from the XADC for temperature compensation. f the XADC is not
currently used anywhere in the design, then enable this option to have it instantiated. Otherwise, the XADC temperature
output value must be connected to the top level temperature input port in the memory interface. See the User Guide for more
information.

User Guide | | version Info | | <Back Cancel
Figure 16: FPGA Options
16. Set the Reference Clock configuration to Use System Clock.
XAPP1162 (v1.0) January 10, 2013 www.xilinx.com "
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17. Click Next.

terface Generator

REFERENCE i

i Internal Termination for High Range Banks

Select the internal tarmination (IN_TERM) impedance for the High Range (HR) banks. This setting applies only to the HR banks
used in the interface.

Internal Termination Impedance 50 Ohms =

DDR3 SDRAM
Digitally Controlled Impedance (DCI)

The DAl (Digitally Controlled Impedance) /0 standards are applied appropriately in High Performance banks. DQ and
DQS/DQS# signals utilize DCl standards (SSTL1S_T_DCI for DQ's and DIFF_SSTL1S_T_DCI for DQS and DQS#). DCl is not
used for the Address/Control output signals, Consult the User Guide for more information and use IBIS simulation to
determine the best termination strategy.

Pin Compatible FPGAs
Memory Selection
Controller Options DQ Cascading Information
AX] Parameter Select the DCI Cascade for the DCl reference pins to achieve better pin efficiency The UCF must be updated manually to
select the Master/Slave banks. Refer to the DOl Cascade section in the 7 Series FPGAs SelectiO Resources User Guide

(UG471) for more information on DCI Cascade and Master/S|, ection
DCI Cascade

Memory Options

S {05,486 6, 6% §

10 Planning Options
Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

Design Notes

& XILINX.

User Guide | | Version Info [ <Back |

i

| cancel

Figure 17: Extended FPGA Options

18. Select the DCI Cascade check box.
19. Click Next.

Memory Interface Generator

REFERENCE Pin/Bank Selection Mode
DesiGN [1]

New Design: Pick the optimum banks for a new design

& Fixed Pin Out: Pre-existing pin out is known and fixed

Pin Compatible FPGAs ¥
Memory Selection v
Controller Options v
AXI Parameter v
Memory Options v
FPGA Options v

Extended FPGA Options¥”

Bank Selection

System Signals Selection
Summary

Simulation Options

PCB Information

Design Notes

& XILINX.

User Guide | | version Info | <Back |[ mex> ]| cancel

Figure 18: 10 Planning Options

20. Select the Fixed Pin Out Pin/Bank Selection mode. You will import the pin configurations
a specified user constraints file (UCF).
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21. Click Next.

REFERENCE
DESIGN [1]

Pin Compatible FPGAs ¥
Memory Selection
Controller Options
AXI Parameter

Memory Options

CCX KX

FPGA Options
Extended FPGA Options?
10 Planning Options ¥

System Signals Selection
Summary

Simulation Options

PCB Information

Design Notes

$ XILINX e

| User Guide | | version info |

Xilinx Memory Intert.

Generator =

Pin Selection For Controller 0 - DDR3 SDRAM

Signal Name Bank Number Byte Number Fin Number 10 Standard  [=]

1 ddr3_dalo] [ all Banks v | select Byte « | select Fin |

2 I ddrs dal1]l | all Banks v | select Byte ~ | select pin -/

3 . ddr3_dalz] | Al Banks ~ | selectByte + | select pin v

4 | ddridai3al | Banks « | select Byte « | select pin vl

5 . ddr3_dql4] | all Banks | | select Byte Tw | select pin -

6 | ddadalsl [AlBanks + |select Byte ~ | select Fin v

7 | ddr3_dol6] \;\ Banks ] v-‘lse\sct e v u.smm Pin .v.}

8 | ddr3_dq(7] ‘AH Banks - ‘l Select Byte - ‘l select Pin - ‘

9 I ddr3_dqle] | Al Banks v | select Byte v | select pin v|

10 | ddr3_dqla] | Al Banks v | select Byte v | select Fin v|

w | da 3dgl1o] | Al Banks « | select Byte « | select pin ~|

12 I | Al Banks v | select Byte v | select pin vl

1| | Al Banks « | select Byte « | select Fin |

2 | | Al Banks « | select Byte « | select pin |

15 : ddr3 dgl14] | All Banks | selectpyte ~ | select pin -

16 | ddradglis] | Al Banks « | select Byte « | select Fin v|

17| ddrsdaiisl | alBanks « | select yte « | select Fin v

18 | ddisdqi7l [l Banks v | select Byte | select pin v

19 . ddrs_dal18] | All Banks ~ |select Byte « | select pin v

20 . ddr3_dql19] | Al Banks « | select Byte « | select pin | | |
I [ = 1 i1 F 1 A

[ Vaiste ([ read x0GUE TNpave Anout]
e ii”

Figure 19: Pin Selection - Import UCF to Configure DDR Pins

22. In the pin selection window, click Read XDC/UCF.
283. Select the pin configuration, and click Open to import it.

REFERENCE
DESIGN [1]

Pin Compatible FPGAs ¥~
Memory Selection v
Controller Options v
AXI Parameter v
Memory Options v
FPGA Options v
Extended FPGA Options ¥~

10 Planning Options ¥~

System Signals Selection
Summary

Simulation Options

PCB Information

Design Notes

= Zen g ==
4
(‘ XI LI NX@ INFO : Press Validate to proceed.

User Guide | | Version Info |

Note: The pin configuration can be found at <reference design path>/IPI_DDR_XAPP/
mig_7_series_pin_layout.ucf.

Xilinx Memory Interface Generator

Pin Selection For Controller 0 - DDR3 SDRAM

Signal Name Bank Number Byte Number Pin Number 10 Standard e
1 [32 v |13 « | aa1s v| ssusToa
2 i [32 v T3 « | anis ~| sstusTDpO
3 ddr3_dql2 [32 v|m v |acia M SSTL15_T_DA
4 |32 Telr + | aD14 7..’\ SSTLIS T_DAl
5 ddr3_dql4] |32 ~ |13 v |am7 ~| ssmusTpa
6 ddr3_dafs] |32 v|T3 « | aB1s v| ssmisToa
7 ddr3_dql |32 v T3 v | AE1S ~| sstusToa
8 [32 vlT3 v |n1s v| ssmstpa
1 [32 v|T2 « | aB19 v|  ssusToa
10 |32 12 « | aD16 ~| ssTusToO
11 |32 Telz v lacie .’\ SSTL1S T DO
12 |32 ~|T2 ~ |ap17 «| ssmusTopa
13 |32 ~ T2 v lams v/ SSTLIS_T DO
14 |32 v |2 + |as18 lw | SSTLIS T_DO
15 [32 v T2 e ~|  ssmsTpa
16 |32 v T2 + | AD1B v

17 |32 ~n « | ac19 ~| ssTusTDO
18 |32 ~in v lakie | SSTL1S_T_ DO
19 [32 Toln « | ac18 v| ssmstoa
20 |32 ~n ~ | aF18 ~| ssTusTDO
21 de [20] |32 ~ T v | AH1g v| ssmstoa

- ) Lana | semistoa )

| validate | (jead xocuCF | [ save Pnout |

| <Back || next> || gancel |

Figure 20: Validate Pin Configuration
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24. Click Validate to open the validation results log.

- . DRC Validation Log message x

1. WARNING - ** for the port “ddr3_addr{0]" is invalid. *FAST" is the valid
Slew rate value Proceed to design generation to get it corrected

2. WARNING : ** for the port "ddr3_addr{10]" is invalid. "FAST" is the valid
Slew rate value. Proceed to design generation to get it corrected,

3. WARNING : = for the port "ddr3_addr{11]" is invalid. "FAST" is the valid
Slew rate value. Proceed to design generation to get it corrected.

4 WARNING : = for the port "ddr3_addr{12]" is invalid. "FAST" is the valid
Slew rate value. Proceed to design generation to get it corrected

5. WARNING - ** for the port "ddr3_addr{131" is invalid. "FAST" is the valid
Slew rate value. Proceed to design generation to get it corrected.

6. WARNING : ** for the port *ddr3_addr[1]* is invalid. *FAST* is the valid
Slew rate value. Proceed to design generation to get it corrected

7. WARNING - ** for the port "ddr3_addr{2]" is invalid. "FAST" is the valid
Slew rate value. Froceed to design generation to get it corrected

| Save Log Message

Figure 21: Accept Validation Log Messages
25. After reviewing the log, click OK.

L Pin Selection For Controller 0 - DDR3 SDRAM
DESIGN [1]
Signal Name Bank Number Byte Number Pin Number 10 Standard B
1 ddr3 |32 v|m o | an1s " SSTL15 T DA |
2 |32 ~ |13 ~ | a5 - sstusToa |
3 ddr3_dql2 3z ~ T3 v | ACi4 - SSTLI5_TDal ‘
a |32 M) ~ | AD14 V| ssustoa |
Pin Compatible FPGAs ¥~ 5 ddr3_dql4 |32 M ) o [amz v| ssmastoa |
Memory Selection v 6 ddr3_dqls 32 v |T3 ~ | AB1S .v.‘ SSTLIS_T_Dal ‘
Controller Options ¥~ 7 ddr3_dgfe 32 v|T3 « | ag1s - SSTLIS_T_DCI
AX] Parameter 4 8 32 ~|T3 vivs v SSTL1S_T_DO
Memory Options v 9 32 Tel= v |am19 v SSTL1S T DAl
FPGA Options v 10 ddr3_dql9 32 lv]m « | a016 v| ssmustoa :
Extended FPGA Options®” 11 ddr3_dql10] |32 v T2 v |ac19 v SSTLIS T DA
10 Planning Options ¥~ 12 ddr3 |32 ~ T2 v |aD17 - SSTLIS_T_DC |
13 32 v |T2 v |anis ~| ssms_topa ‘
System Signals Selection 14 32 v|T2 « | aB18 v| ssusToa
Summary 15 [32 Tv|m2 « | ac18 [v ssmusToa |
Simulation Options 16 ddr3_dql15 [32 |2 ~ |ab1s v| ssmusToa ‘
PCB Information 17 ddr3_dql16] 32 v[n « | ac19 - SSTLIS T.DC
Design Notes 18 |32 ~ T - axg v SSTLIS_ T DOl
19 3z v T v |ac18 V| ssustoa |
20 32 v v | AF18 - SSTLIS_T DOl |
21 32 ~|m « | aH19 v| ssmsTpa
- ddr3_dat211 - S o Lano b ccnmisTnA )
v
i‘ XI LI NX@ INFO : Validation successful. Press Next to proceed. [ validate ] [Read XDC/UCF | [Save PnOut |
User Guide | | Version Info | [ <Back Cancel |

Figure 22: Pin Selection Complete

26. Click Next to show the clocking configurations.
27. Click Next to open a summarized report.
28. Click Next to open the simulation model license agreement.
29. Click Accept to accept the license agreement.
30. Click Next to open a PCB configuration note.
31. Click Next.
The design notes opens.
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32. Click Generate to generate the mig_7_series ddr3 IP.

Figure 23 shows the configuration of Mig_7_series DDRS3 IP after customizing it using the
Xilinx Memory Interface Generator.

mig_7series_1

DDR3 4k |||
init_calib_complete
ui_clk
ui_clk_sync_rst

Figure 23: DDR3SDRAM

Customizing a MicroBlaze Processor
1. To customize a MicroBlaze processor, double-click on it.
The Customization Options dialog box opens.

Re-customize IP

x|
Re-customize MicroBlaze (8.40.k) by “En
Q specifying IP Options ‘ & Advanced H b I
P Options
MicroBlaze
e Component Name [design_L_micrablaze_1_0 ]
T —— Welcome to MicroBlaze Configuration Wizard
. Area - - -
- pertarmance Micro3laze
Resource Estimates Usage Information 2
@ Select a preclefined configuration with Select Configuration below. Information
100.0 apout the selected configuration can be found in the woltip. Each predefined
configuration completely changes the MicroBlaze parameters.
90.0
@ Ta modify the configuration, click on the Next button, click on the yellow Advarced
80.0 button at the top to directly access parameters in a tabbed Interface, or click OK to
accept the configuration and close the dialog.
70.0
&
g 00 Predefined Configurations 2
90800 Select Configuration |[Current Settings -]
40.0
General Settings A
30,0
[C]Select implementation to optimize area (with lower instruction throughput)
20.0
7] Enahle MicroBlaze Debug Module Imerface
10.0
@JSE Instruction and Data Caches 1
0.0 -
[] Enable Exceptions
[ Use Memory =
T‘l"““‘“““““““—}, i EF ack || Next > | Pageiors
Show Acvanced Options
| o || cancel

Figure 24: Enable Instruction and Data Caches

2. Enable Instruction and Data caches.
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3. Click Next.

X Re-customize IP. x|

| Re-customize MicroBlaze (3.40.k) by
Pl labcencee. )] L)
IP Options

MicroBlaze

¥

IF Symbo!  Resources

Frequency Sz
i Instructions 2
. Performance
e @Enaule Barrel Shifter
Resource Estimates
Enable Floating Paint Unit | |BAGIC -]
100.0 Enable Integer Multiplier ll
2004 (Denavle integer Ciider
80.0 [ Enable Additional Machine Status Register Instructions
70.01 = [] Enable Paitern Comparatar 3
g 60.0 ¥ Enable Reversed Load/Store and Swap Instructions
£ soo [ Enable Additional Stream Instructions
g
40.0
Optimization 2
384 [ Select implementation to aptimize area fwith lower Instructian throughputy
2050 @Enanle Branch Target Cache
10,0 Branch Target Cache Size |DEFALLT =]
0.0 3 »
| Fault Tolerance % |
=] =
1 i [+ <Back | Next» | Pagezors
Shove Advanced Options
[ o ]| cance

Figure 25: Configure General Settings for MicroBlaze Processor

4. Enable the following:
* Barrel Shifter
e Use Integer Multiplier MUL32 (32-bit)
* Use of basic floating point unit
* Integer Divider
e Branch Target Cache
5. Click Next.

R Re-customize |IP
| Re-customize MicroBlaze (8.40.b) by T
6/’ specifying IP Options. [ #atvancea | B |
IP Options
MicroBlaze

B by Resainces Component Name  [design_T_microblaze_1_0 |

Frequency 2ailie
. Area [ Enable Instruction Cache 7] Enable Data Cache
W Performance
Instruction Cache Feature : 3 Data Cache Feature A

Resource Estimates

Size In Bytes Gy [ Size In Bytes Czaey [+
e Line Length Line Length Gy [
i Base Address 0x80000000 Base Address € |0xB00000009 |
High Address  €CJOXFFFFFFFF ) High Address  CJOXFFFFFFFE 3 |
2004 L
= [# Enable Writes [ Enable Writes
70.01
& @sa Cathe for All Mermory Accesses @se Cathe for All Memory Accesses|
50.0
§ [ Use Distributed RaM for Tags [Cluse Distributed RAM for Tags
5 500
B0 Data Width Data Width [z2-bit =1
50 Number of Streams [] Enable Write-back Storage Policy
o Number of Victims Number of Victims [0 =l
10.0
0.0 3

4 =il 1 EE <Back |[ Next> | Pagesofs

[ ok [ cancel |

Figure 26: Configure Instruction Cache and Data Cache Settings for MicroBlaze Processor
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10.

11.

12.

Set the size of both Instruction Cache and Data Cache to 32 KB.

Set line length of both Instruction Cache and Data Cache to 8.

Set High Address of both Instruction Cache and Data Cache to 0xFFFFFFFF.
Set Base Address of both Instruction Cache and Data Cache to 0x80000000.

Note: Ensure that you set the High Address before you set the Base Address so that Base Address
is not greater than High Address at any time.

Enable Use Cache for All Memory Accesses for both Instruction Cache and Data Cache.

Next, ensure that the size of the cacheable segment of memory (that is, the memory space
between the Base and High addresses of the Instruction_Cache/Data_Cache) is a power
of 2.

Additionally, the base address and the high address of both Data Cache and Instruction
Cache should be the same.

Ensure that all IPs that are slaves of the ICache and DCache busses fall within this
cacheable segment. Otherwise, read/write functions cannot be performed on them.

Note: For any IP connected only to the Instruction Cache and Data Cache bus, you must enable the
Use Cache for All Memory Access option. In this example, the ICache and DCache buses are the
sole masters of DDR and block RAM; therefore, this option must be enabled. In other configurations,
you must decide whether to enable this option as per the design.

Click Next.

Re-customize 1P x|

0 Re-custormize MicroBlaze (8.40.k) by
specifing IP Options
IP Options

MicroBlaze

IFSeroir” Resoures Component Name [desion_1_microblaze 1 0 |

| @yavances | B |

Frecuancy Debug

. Area
W Performance

[¥] Enable MicroBlaze Debug Module Interface

Haraware Breakpoints F3
1 ] Ramgemo.B

Number of Write Address Watchpoints [0 Range: 0.4

Nurnber of Read Address Warchpoints [0 | Range: 0.4

Resource Estimates
Nurnber of PC Breakpoints

100.0

90.0 |
80.0
70.0
§0.0

50.0

Percent (%)

40.0

30.0

20.0

10.0

0.0

| — NS

< Back \@ Page 4 of 5

[ ox

Shove Advanced Options

J[cancer ]
Figure 27: Enable MicroBlaze Debug Module for MicroBlaze Processor

Make sure that MicroBlaze Debug Module is enabled.
Click Next.
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% Re-customize IP x|
0 Re-customize MicroBlaze (8.40.b) by -
specifying IF Options. | 0y Actvancec ‘ﬂ
IP Options
MicroBlaze

P Sytsl” Resauites Component Name [design_1_microblaze_1_0 ]
Frequency Blses

. Area Local Memory Bus Interfaces 2

. Performance

] Enable Local Memary Bus Instruction Interface
Resource Estimates
7] Enable Local Memory Bus Data Interface
00 AX| Peripheral Interfaces 2
Cleie [JEnable Peripheral Ax| Instruction Interface
e Clzl}nab\e Peripheral AX| Data Interface
70.0
2

§ c00 Stream Interfaces S

2 Humber of Stream Links [0 Range: 0,16

5 500
40,0 Other Imerfaces 2
30,0 []Enable Trace Bus Interface
200 Lockstep Imerface [NONE [=]
10.0

0.0 =
i | -
e [ <pack || meas | Pagesors
Show Advanced Options
| ok || cance

Figure 28: Enable Peripheral AXI Data Interface

13. Check Enable Peripheral AXI Data Interface.
14. Click OK to generate re-configured MicroBlaze processor.
Figure 29 shows the configuration of the MicroBlaze processor after re-customizing it.

microblaze_1

Il INTERRUPT [Tt::i H
I ?KDEBUG M_AXI_DPdp i
B et M_AXI_DC dia fi

M_AXI_|C dh F

Figure 29: Re-Customized MicroBlaze Processor

Making a Connection Between Two Ports
To make a connection between two ports:
1. Hover your mouse cursor over one of the two ports.

The cursor changes to a pencil icon to signify that a connection can be "drawn."

2. Click on the port and drag the cursor away from it. After a small distance, you can stop
dragging; notice that a connection is following your cursor.
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The possible connections are identified with a check mark, as shown in Figure 30.

Note: The ports that are identified are compatible ports; they are not necessarily the correct ports
for a connection.

mig_7series_1 microblaze_1

DLMBHR
ILMB R
—aresetn M_AXI_DPdk i

ui_clk —Clk .
—sys_clk_ - M_AXI_DCqF (i
y 3 \ —Reset -

ui_clk_sync_rst — H
—isys_clk_n M_AXI_IC ok {::

Found & ports

Hdns_axi

|| 4=INTERRUPT
sys_rst

arDEBUG

DDR3 - |||
init_calib_complete —

Figure 30: Starting a Connection

3. To complete your connection, click on the connecting port.
The connection line turns dark to identify that a connection is made.

mig_7series_1 microblaze_1

3| qpS_AXI DLMB4F
» DDR3 4 || ||| <= INTERRUPT I
—sys_rst Y . ILMB gk "
init_calib_complete - " ar DEBUG .
—aresetn ) M_AXI_DPqp {::
ui_clk Clk .
—sys_clk_p ) M_AXI_DCF [::
ui_clk_sync_rst — —Reset .
—sys_clk_n M_AXI_ICqp i
- Connect from 'vi_clk' port to 'Clk’ port|

Figure 31: Completing a Connection

Note: If at any time you do not want to make the connection, you can terminate it. To do so,
right-click on any empty area in the block diagram and select End Connection Mode. Alternatively,

you can press the Esc key on your keyboard.

mig_7 series_1 & Block Pin Properties... crve M
|;|'}:|5_A)(| i Copy Ctrl+C
- DDR3 4k |||
—{sys_rst L Select A Chrla
Inlt_callb_complete —
—aresetn _ H End Connection Mocle
ui_clk S
_SVS—CIk—p Ul C“( sync rst Create Hierarchy. ..
—sys_clk_n
Create Port...
Disconnect Pin r
) sawve as PDF File... L

Figure 32: Ending a Connection

XAPP1162 (v1.0) January 10, 2013 www.xilinx.com 19


http://www.xilinx.com

Hardware Reference System & XILINX.

Creating First Design Connections

The clock in this system is driven by the ui_c1k port of mig_7_series DDRS3 IP. Make the
following connections:

Connect the ui_c1k port of mig_7_series to the C1k port of the MicroBlaze processor.

2. Connect the ui_c1k port of mig_7_series to the Slowest_sync_clk port of
proc_sys_reset.

3. Connectthe ui_clk_sync_rst port of mig_7_series to the Ext_Reset_In port of
proc_sys_reset.

4. Connect the MB_Reset port of proc_sys_reset to the Reset port of the MicroBlaze
processor.

5. Connect the MBDEBUG_ 0 bus interface of the mdm to the DEBUG interface of MicroBlaze
processor.

6. Connect the Debug_SYS_Rst port of mdm to the MB_Debug_Sys_Rst port of
proc_sys_reset.

Figure 33 shows the connected system.

~ mdm_1 proc_sys_reset_1
MBDEBUG 04k ||| lsi t_sync_clk MB_Reset
Interrupt Ext_Reset_In Bus_Struct_Reset[0:0]
Debug SYS_Rst Aux_Reset_In Peripheral_Reset[0:0]
MB_Debug_Sys_Rst Interconnect_aresetn[0:0]
Dcm_locked Peripheral_aresetn[0:0]
mig_7series_1 microblaze_1
DLMBgp
DDR3 4k ||| ||| 4= iNTERRUPT M & H
init_calib_complete f- ||| 4xDEBUG 5
M_AXI_DPdh i
ui_clk clk 4
M_AX|_DCHF {3}
ui_clk_sync_rst Reset H
M_AXI_IC R (i

Figure 33: Creating First Connections
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Adding Local Memory

1. Add two local memory buses (LMB), two LMB block RAM controllers, and one block
memory generator.

Re-customize IP

0 Re-customize Block Memory Generator " |
(7 3) by specifying IP Options

IP Options

Block Memory Generator

IP Symbol  Power Estimation

1Show Disabled Ports Basic | Port AOptions FPort B Options  Other Options ~ Summary

Mode BRAM Controller EljD ]

Memory Typal TTrue Dual Port RAM BD

ECC Options z
ll|-BrRAM PORTA write Enaple 2
lll=BrAM_PORTE . g

Algorithm Options. 2

Definas the algorithm used to concatenate the block RAM primitives.

Refer datasheet for more information

Show Advanced Options

| OK. | cancel .

Figure 34: Configuring Block Memory Generator

2. In the Basic tab, customize the block memory generator as follows:
* Set Mode to BRAM Controller.
* Set the Memory Type to True Dual Port RAM.
3. Make the following connections. The connected system is shown in Figure 35.
* Connect the ui_c1k port of mig_7_series to all LMB_C1k ports of the local memory
buses and the Imb_bram_controllers.

e Connect the Bus_Struct_Reset[0:0] port of proc_sys_reset to the SYS_Rst
ports of the local memory buses.

e Connect the LMB_M bus of one LMB to the DLMB bus of the MicroBlaze processor, and
the LMB_M bus of the other LMB to the I1.MB bus of the MicroBlaze processor.

Imk_vw10_1

Imb_bram_if_cntlr_1

|| B
LMB_Clk  LMB_51_0 i ||| s 5LME

SYS_Rst LMB_Clk  BRAM_PORTHb ||
_| blk_merm _gen_1
Imb_v10_2 i II| 4 BRAM_PORTA
1| Lhag_pa Imb_bram_if_entlr_2 IIl4= BRAM_PoRTE
LME_Clk  LMB_51_0 i || ||| 5 SLME |

5YS_Rst

Figure 35: Creating Local Memory
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r ) 10 1 1
proc_sys_reset_1 [If+rLz_ra
lowest_syne_clk MB_Resett— LMB_Clk  LMEB_SI_0=k ||_|| L S L ME
Ext_Reset_In Bus_Struct_Reset[0:0] S_Rst B BRAM_PORT 4 |
set_ln Peripheral_Reset[0:0] = L 21 r mern gen_ ley
MB_Debug Sys_Rst  Interconnect_aresetn[0:0] = 4 | il
Dem_locked Peripheral_aresetn[0:0] = r mb wlo -1 ” -.:- 0
_ . 2 BRAM_PORTE
e linb bram if cnilr 2 ey
M L | af L -
microblaze_1 e 4 Block Properties. .. Ctrl+E " |
- S_Rs =
4 DLME -+ L X Delete Delete
||| -+ INTERRUPT o [y Copy Cri+C 2
— Il Ll o | B Paste —
[ M_AXI_DC =k ki Select All CHri+a
M_AXIIC - 5 G Add 1P
| Create Hierarchy... |
Create External nnect
Create Port...
Create Interface Port
¥ Customize Block...
Orientation »
® save as PDF File...

Figure 36: Creating a Hierarchy - Local Memory

4, Ctrl + click to select the five IPs: two LMB, two LMB block RAM controllers, and one block
memory generator. Right-click and select Create Hierarchy. Name the hierarchy.

The five blocks collapse into a wrapper box, as shown in Figure 37.

_reset_1

ME_Reset)
Bus_Struct_Reset[0:0]
Peripheral_Reset[0:0]

terconnect_aresetn[0:0]§=
Peripheral_aresetn[0:0]=

local_memo

M_p_ic g
MEB_Halted

Sleep
Dbg_Wakeup

Figure 37: Hierarchy Collapsed

5. Click the + sign at the top left corner of the hierarchy box to expand the hierarchy.

ESEL_L

MB_Reset

Bus_Struct |
Peripheral_Reset[0:0]
connectaresatn[0:0]f=
rHipheral_srezetn[0:0]p=

local_memory

. . Imbwl0.2
LMB M H _LLMB_M Imb_bram_if_cntir_2 = blk_mem_gen_1
B.Clk  LMESID.} |||-351mE |||=kBRAM_PORTA '
5_Rat ——LME_Clk  BRAM_PORT -} |||-eram_rorTE
—LMB_Rst
Imb_w10_1

LME_ M1 “t‘}u“_m ) Imb_bram_If_crtir 1

LMACIK I:a_m LMB_$10 -3 [||-ss10a8

SYS_Rst| Y5 _Rat y——LMECIk  BRAM_PORT
- —{LMB_R:s1

Figure 38: Hierarchy Expanded
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Adding Memory
1. Add an AXI4 Interconnect and customize it for two slave ports and two master ports.

Note: In this design we will be adding AXI4 block RAM Interface controller and mig_7_series to this
AXI4 Interconnect. If you need to add more IPs to interconnect, update this accordingly.

Rl.r_— cus;n:nl.zn IP

o_ Re-customize AX|4 Interconnect (2.0) by | Lo J
* specifying IP Options.

IP Options
AXI4 Interconnect

Toplevel Settings  Slave Interfaces  Master Interfaces

Interconnect Optimization Strategy |Current Settings EJ|

Number of Slave Interfaces

Mumber of Master Interfaces

Show Advanced Options

| ok || cancel |

Figure 39: Customizing AXI4 Interconnect

2. To one slave Interface of the AXI4 Interconnect S00_AXI, connect the M_AXI_DC
(DCache) interface of the MicroBlaze processor. To the other slave Interface of the AXI4
Interconnect, such as s01_AX1I, connect the M_aAXI_1C (ICache) interface of the
MicroBlaze processor.

microblaze_1 J
pLmBs ]

” i::[)\JETBITJFEZRUPT [LM B |'—I axi_interconnect_1
o M_AX|_DP X
Reset M _43X|_DCeh _ h500_AXI
M_AXI_IC e [ e 1 1501 _ AN
—ACLK
— ARESETHN
—500_ACLK

SOO_ARESETN MOO_AXI b
—MOO_ACLK  MO1_AXIda
MOO_ARESETN
MO1_ACLK

MO1_ARESETN
SO1_ACLK

SO1_ARESETN

Figure 40: Connecting ICache and DCache to the AXI4 Interconnect
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3. Add an AXIl4 Interface Bram controller and a block memory generator.

0 Re-customize Block Memory Generator o ‘
(7.2) by specifying IP Options.

IP Options

Block Memory Generator

IP Symboel Power Estimation

Show Disabled Ports Basic | Port AOptions Port B Options  Other Options ~ Summary

Mode BRAM Controller ?\D
Memory Type]T rue Dual Port RAM QD

ECC Options %

ll| =8RAM_PORTA
llf2=8rAM_PORTE

Write Enable 2

Algarithm Options &
Defines the algorithm used to concatenate the block RAM primitives
Refel i I

[ ok || cancel

Figure 41: Customizing Block Memory Generator

Configure the block memory generator for BRAM Controller mode and True Dual Port RAM
memory type.

Make the following connections:

a.

Connect BRaM_PORTA of the Block Memory Generator to BRAM_PORTA of the AXI4
Interface Bram controller, and BRAM_PORTB of the Block Memory Generator to
BRAM_PORTB of the AXI4 Interface Bram controller.

Connect the s_aX1 bus of the AXI4 Bram controller to the master interface M00_AXT
of the AXI4 Interconnect (axi_interconnect_1).

Connect the s_AXI bus of the mig_7_series DDRS3 to the other master port M01_AXT
of the AXI4 Interconnect (axi_interconnect_1).

Connect all clock ports of the AXI Interconnect (ACLK, Sxx_ACLK, Mxx_ACLK) clock to
the ui_c1lk port of mig_7_series DDRS.

Connect the s_aAxI_AcCLK port of the AXI4 Interface Bram controller to the ui_clk
port of the mig_7_series.

Connect the ARESETN port of the AXI4 Interconnect to the
Interconnect_areset[0:0] port of proc_sys_reset.

Connect the Sxx_ARESETN pins and the Mxx_ARESETN pins of the AXI4 Interconnect
to the Peripheral_aresetn[0:0] pins of proc_sys_reset.

Connect the s_axTI_ARESETN port of the AXI4 Interface Bram controller and the
aresetn port of mig_7_series to the Peripheral_aresetn[0:0] port of
proc_sys_reset.

The connections you just made are shown in Table 3. Each row in the table represents a
connection/net to be made. Refer to Figure 42 for these connections.
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Table 3: Memory Connections

. AXI4 Interface
AX14 Mig 7 Block Memory
2 BRAM Proc_sys_reset
Interconnect_1 Series Controller Generator
1 BRAM_PORTA | BRAM_PORTA
2 BRAM_PORTB | BRAM_PORTB
3 | MOO_AXI S_AXI
4 | MO1_AXI S_AXI
5 | ACLK ui_clk S_AXI_ACLK
S00_ACLK
S01_ACLK
MOO_ACLK
MO1_ACLK
6 | ARESETN Interconnect_aresetn[0:0]
7 | SO0_ARESETN S_AXI_ Peripheral_aresetn[0:0]
S01_ARESETN ARESETN
MOO_ARESETN
MO1_ARESETN
|
axi_interconnact_l I
= , o ) axi_bram_ctrl_1 T —
esoraa [ s-s BRAM_PORTAL: [|} 1l o -r_pc;k'rAi I
:::ZTK :ﬁ:::i:!‘:m BRAM_PORTB 4= ||| ::{ _PORTB
- = —— e a—
.—nm:ﬁigm fsw_’:‘ DDRz 4 (|| Ext_Resetin Bus_Struct_Reset[0
— i TR ﬁﬁi’}!ﬁfﬁ;ﬁ?ﬁﬂ ey
S01_ARESETH .4 N ui_clk_sync_rst —Dcm_locked il _aresetn[0:0]
Figure 42: AXI Interconnect to Memory Connections

Adding Peripherals
1. Add another AXI4 Interconnect and configure it for one slave and three master ports.
2. Add an AXI Timer, AXI INTC (Interrupt Controller), and AXl UARTLite.

Note: You can maximize the block diagram to increase the working area. This can be helpful in
speeding things up. You can also float the block diagram window and scale it to a larger size. These
buttons are located on the top left hand corner of the block diagram window.

Figure 43: Float/Maximize Block Diagram Window Buttons
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Make the following connections:

a. Connectthe AXI Data Peripheral Interface (M_aAXI_DP) of the MicroBlaze processor to
the slave port s00_aXT of the AXI4 Interconnect that you added (axi_interconnect_2).

b. Connect the s_aXx1T interface of the AXI Timer to a master port of the AXI4
Interconnect(2) that you added.

c. Connectthe s_axT interface of the AXI INTC to one of the two remaining master ports
of the AXI14 Interconnect(2).

d. Connect the s_aAXT interface of the AXI Uartlite to the remaining master port of the
AXI4 Interconnect(2).

e. Connect the clock from ui_c1k port of mig_7_series to:

- S_AXI_ACLK port and Processor_clk port of AXI INTC
- S_AXI_ACLK port of AXI Timer

- S_AXI_ACLK port of AXI Uartlite

- All AXl4 Interconnect ACLK ports, all slave sxx_ACLK ports, and all master
Mxx_ACLK ports

f. Connect the Peripheral_aresetn[0:0] port of proc_sys_reset to:
- S_AXI_ARESETN port of AXI INTC
- S_AXI_ARESETN port of AXI Timer

- S_AXI_ARESETN port of AXI Uartlite

- All AXI4 Interconnect slave Sxx_ARESETN ports and all master Mxx_ARESETN

ports.

g. Connect the MB_Reset port of proc_sys_reset to the Processor_rst port of AXI

INTC.

h. Connectthe Interconnect_aresetn[0:0] portof proc_sys_resetto the ARESETN
port of AXI4 Interconnect.

The connections you just made are shown in Table 4. Each row in the table represents a
connection/net to be made). Refer to Figure 44 for these connections.

Table 4: Peripheral Connections

IntercAo)r(llr?ect_Z é\nelge-; AX14 Timer AXI4 INTC UAQ¥II_ite Prc:ggz}/s_
1 | MOO_AXI S_AXI
2 | MO1_AXI S_AXI
3 | MO2_AXI S_AXI
4 | ACLK ui_clk S_AXI_ACLK | Processor_clk | S_AXI_ACLK
S00_ACLK S_AXI_ACLK
MOO_ACLK
MO1_ACLK
MO02_ACLK
5 | ARESETN Interconnect
_aresetn[0:0]
6 | SO0_ARESETN S_AXI_ S_AXI_ S_AXI_ Peripheral _
MOO_ARESETN ARESETN ARESETN ARESETN aresetn[0:0]
MO1_ARESETN
MO02_ARESETN
7 Processor_rst MB_Reset
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axi_timer_1
s a
—(CaptureTrigd  GenerateOuto|
microblaze_1_axi_periph —{CaptureTrigl  GenerateOut1
—Freeze PWMO
| 2500_AXI ——————S_AXI_ACLK Interrupt
X LK pe=—S_AX|_ARESETN
microblaze_1 -
oL _ACLK
||| =INTERRUPT axi_uartlite_1
L _ARESETN MO0 i = =
———||[=pEBUG ; ~
Il M_AXI_DI _ACLK MO1_AXI<} i | s _axi
—ak i = vart ||
M_AX1_DCdp _ARESETN MO02_, qpi:E XI_ACLK.
————Reset ] Interrupt
M_AXI_ICe _ACLK _AXI_ARESETN
_ARESETN
_ACLK
_ARESETN
proc_sys_reset_1 Suiliter mig_7series_1
—Islowest_sync_clk MB_Reset H 4}7 i@ porad ||
L—ilhs_axi a
Ext_Reset_In Bus_Struct_Reset[0:0] e —isys_rst
_AXI_ACLK | init_calib_complete
—Aux_Reset_In Peripheral_Reset[0:0]f P faresetn -
y ui_c
jME_Debug_Sys_Rs( Interconnect_aresetn[0: —— interrupt < [[| —sys_clk_p A .
- ui_clk_sync_rsf
Dem_locked Peripheral_ares: —isys_clk_n 4
; ocessor_clk |
ocessor_rst

Figure 44: AXI4 Interconnect to IP Peripherals Connections

Add IP Concat

1. Add the concatenate tool, simply called Concat. This is used to "concatenate" the interrupt
signals generated from AXI Timer and AXI UARTLite.

Connect the Interrupt port of AXI Timer to the input port In0[0:0] of Concat.
Connect the Interrupt port of AXlI UARTLite to the input port In1[0:0] of Concat.
Connect the output pin dout [1:0] of Concat to the Intr[0:0] pin of AXI INTC.

Connect the Interrupt interface of the AXI INTC to the INTERRUPT interface of
MicroBlaze processor.

A A

Figure 45 displays the connections for adding IP Concat.

microblaze_1 |
DLMB: axi_timer_1
||| 4 INTERRUPT "
i ILMB
|||4DEBUG .
v M_AX| _DP s fif et CaptureTrigd  GenerateOutO
M_AX|_DC dp fim— CaptureTrigl ~ GenerateOut1
M_AXI_IC

-_—

axi_intc_1
s _axi axi_uartlite_1
_AXI_ACLK i
uart g
AUARESETN e rupt e | Interrupt "—
e Intr[0:0] AXI_ARESETN

Processor_clk
Processor_rst

xlconcat_1

In0[0:0]

dout[1:0]
In1[0:0]

Figure 45: Adding IP Concat to Connect Interrupt Signals in the Design.
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Configure the UARTL.ite interface

1. Click on the + sign next to the uart interface to expand it.
The interface expands, showing two pins: TX and RX.

axi_uartlite_1

.s - | uar "
iijgPs_ax
3 TX B
S_AXI_ACLK
RX 4
S_AXI_ARESETN
Interrupt

Figure 46: Expanding UART Interface Port of AXI UARTLite
2. Select the TX pin by clicking on it.

Caution! Make sure that the port is selected when you create a new port. This ensures that the new

port connects to the selected port. Alternately, you can create a port independently and manually
create the connection to the pin.

3. Right-click on the TX pin while it is selected and select Create Port.

axi_uartlite_1

H uart= "I
ii|qrs_ax :
S_AXI_ACLK 3 Block Pin Properties Ctri+E
SAXIARESETN ' | Xoe o
ey Interrupt & ECDW A
& Select All Ctri+A

Start Connection Mode
& add P,
[ Create Hierarchy:
Create External Connection
Create Port..

B Save as PDF File. ..

Figure 47: Creating a Port

4. In the create port options, select Data under Type.

Create Port

9 Create port and cannect it 1o selected pins and pons

Port name: [T ]
Direction; Qutput = |
Tuwpe! |others -

[ Create vector: <2 [

T
Reset - —= " L =
) Connect 1o 'TXedlotaraa
LData J

[CTock Enable | | oK, ] |
Others

Cancel |

Figure 48: Configuring a Port During Creation
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5. Click OK.
A new port is added, as displayed in Figure 49.

axi_uartlite_1
p
== uartc=— ”
il ghs_axi
- TX b X
—S_AXI_ACLK iy — 2
—iS_AXI_ARESETN
Interrupt

Figure 49: Port Created for TX

6. Create a port for RX. In the create port options, select the direction input and type as Data.
Your AXI UARTLite IP will be similar to Figure 50.

axi_uartlite_1 __
" uart= ||
“aa S_aXl
= ™@r ——_ B TX
—S_AXI_ACLK
RX4 =——<_JRX
— S_AXI_ARESETN
Interrupt

Figure 50: Created Port for RX

7. Alternately, you can do the following. To skip these steps, go to Creating Input Clock and
Reset Ports for mig_7_series, page 30.

a. Select the uart interface pin by clicking on it.

axi_uartlite_1

-

gps_axi
—S_AXI_ACLK

0] al’t 4]= I I i Black Interface Properties... Ctri+E

X Delete Delete

Interrupt i A
S_AXI_ARESETN i Select Al Cirl+ i
Start Connection Mode
0 add 1P

Create Hierarchy...

Create External Connection
Create Part...

| Create Interface Port... |

Disconnect Pin

T Save as PDF File...

Figure 51: Creating an Interface Port

b. Right-click on the pin and select Create Interface Port. This creates an interface port
that will map all the ports in the interface.
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_l:'. reate i;te rface Port

-
0 Create interface port

e

Interface name; [lar |

WLMNY; |xilinx.com:embedded:ioif_uar‘t_r‘tl:1.0 bt |

Mode: MASTER. -

[# Connect to selected interface uart

[ ok | " Cancel |

Figure 52: Interface Port Settings

c. Click OK in the dialog box that opens.

An interface port is created. Select the interface port by clicking on it and you can see
it listed as an External Interface in the design hierarchy tab and you can see the
individual ports by expanding the interface by clicking on the + sign next to it.

| Block Design - design_1 *

Design Hierarchy — O % | M address Editor X §=Diagram x

[ E]] S A, design_1 »

o [~] ay D_AAI_ALLK mnterrupt
I External Interfaces l IS
@ uan j\’_-:‘S_AXI_ARESEI'N

< uan_txd
O uart_rxd
T Terace Cannecions
< mdm_1_mbdebug. 0

icroklaze. 1 dimb
icroblaze. 1iimb

)
I
L=
S
= axi.interconnect.1.moo ax| & axi_uartlite_l
3
®

@ axi_interconnect.1.mo1_axi
= axi_bram_etri_1_bram_parta 5

& Sources B Design Hierarchy s i} TR S _2X
i vartd ||| > uart
External Inerface Properties _ouweox S_AXI_ACLK

« »[@E[k] Interrupt
 uart I S_AXI_ARESETN k-

Name: uart

Mode: [masTEs |

Connection | = axi_uartlite_1_uan

General Attributes [a ]

Tel Console

i | | connect_bi_net [get_bi_pins /axi_tiner_L/Interrupt] [get_bd_pins /concat 1/In0]

Figure 53: Viewing Individual Ports of the Interface Port

Creating Input Clock and Reset Ports for mig_7_series
1. Select the sys_clk_p port of mig_7_series by clicking on it.
2. Right-click the port and select Create Port.

Make sure that the port is selected when you create a new port. This ensures that the new

port connects to the selected port. Alternately, you can create a port independently and
manually create the connection to the pin.

—| mig_7series_1
| dhs_axi
= DRz ||
—{sys_rst
init_calib_complete
aresetn )
I ui_clk,
- o . ]
& Block Pin Properties. e [ [ Srodads Pur = -
X Delete Delete o Create port and connect t to selected pins and ports 7series_1
[ Copy ARk
B Pasie cirliy b DDR3eh |
I Select All oy Port name: [Fyvs.clk-p ] T Tl ece
Stant Connection Mode Direction uiclk
&
EEZE R => o ui_clk_sync_rst
Create Hierarchy, — -
Create External Connection Dl Create vector:  from [ 1] o | o
r Create Port,.. (7] Connect to 'sys_clk_p' selected pin
e wicrabTal Disconmect Fin F _
) Save as POF Flle C o P cancel

Figure 54: Creating Port for sys_clk_p Port of DDR
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3. Create ports for sys_clk_n and sys_rst ports of mig_7_series.

4. Right-click the DDR3 interface and select Create Interface Port to create an interface port.

DDR now has the ports shown in Figure 55.

-

H|dhs_AXI
sys_rst & sys_rst
aresetn
sys_clk_p[_» sys_clk_p
sys_clk_n > sys_clk_n

mig_7series_1

DDR3 %}"—

init_calib_complete
ui_clk
ui_clk_sync_rst

Figure 565: Mig_7_Series Ports

Creating Constraints

Your IP integrator block design is now complete.

DDR3]

Next, create a constraint (.xdc) file to map the ports that you created in the block diagram.

1.

In the Flow Navigator tab of the Vivado IDE, go to the Project Manager.

Eile Edit Flow Tools Window Layout Yiew Help

FEI

«

Flow Navigatar Project Manager - project_2

bl X |9 D ¥ & K L (@ IS Defaur Layout - | K| &

%] Open Static Simulation

« =+ %
wa constrs_ 1

.

RTL Analysls

Az Clourees o
=T | ma ok |
X 1| m g¥ | B (E
4 Project Manager P
@ Design Sources (1)
bR G- @ design_1_wrapper n.1
&% Add Sources & design_1_i - design_1 (design_1
LF 1P Catalos @@ design. 1 (2 ) (1
- o @ Constraints (1)
4 1P Integrator & () Simulation Sources (1
4% Create Block Design
5¥ Open Block Design
4 Simulation Hierarchy IP Sources | Libraries Compile Order
& simulation Settings Z Sources 7 Templates
@ Run Simulation Constraim Set Properties O %

@¥ Open Elaborated Desigl | | pefault directory.

File count 1

xDC

N

Synthesis
@ synthesis Settings
& Run Synthesis

Format:

Target constraint file:

1)

fprnJ;ms/usersf\,asnnuaflﬁ,mtegramr/[

3

E Project Summary %

= @ Project Settings

= Project name: 3

Proguct farmily: K
Project part: K
Top module name: ¢

P synthesis

Staws: ¥ Out-of
XETK2ZSH

V¥ivado Svn

Part:
Strategy:

@ DRC violations

[ ]

Figure 56: Add Constraints

2. Open the Constraints folder.

&% Open Synthesized Desig U Warnings
General | Attributes [ s
4 Implementation
nf‘ ot Design Runs
B it =
< eings | o [Name [Pan [Constraints [ Strategy
[» Run Implementation = [@ ¢ synth_1 %C7K3251gI00-2 constrs_ 1 Vivado Synthesis Defal
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Right-click the constraints set and select Edit Constraints Sets.

project_2 - [/proj/ips/users/yashovallP;

File Edit Flow Tools MWindow Lawout Wiew Help
A2 neRk X >N S X LG [E0dauaon 1% |®

«| | Project Manager - project._2

Flow Navigator

aze Sources — @ =
S - Y
4 Project Manager J
S 57 Design Sources (1)

4% Project Setings b4 design_1_wrapper ( ) (1)

&% Add Sources @- i, design_1_1 - design_1

&= g design_1 (cdesion
IP Catal ht R
Q: BELY (= Constraints (1)
=):

4 IP Integrator . Simulatiol G Constraint Set Properties... Cti+E

*

475 Create Block Design Hierarchy Update »

5% Open Block Design @ Refresh Hierarchy
4 Simulation Hierarchy IP gl Al

& Simulation Setings £ SourcéS] Eciit Constraints Sets... In]

Ec S
E@. Run Simulation Constraint Set Associate ELF Files L
Tl Open Static Simulation | | 4= < @ Add Sources... ANHA
trs_1
4 RTL Analysis =
> fg¥ Open Elaborated Desiar | | pefault directory: nrajfipsjusers fyashova/IP_Inegrator,
Fil t 1
4 Synthesis R
Farmat HDC

&4 sunthesis Settinos

Figure 57: Edit Constraints Set

In the Edit Constraints Set dialog box, click Create File.

Give your file a name and click OK.

The Edit Constraints Set dialog box shows the new file.

Click OK.

Double click the file under the constraints set to open it.
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.

.

.

.
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x
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Figure 58: Open Constraints File

This file specifies local constraints for the ports created in the block diagram.
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9.

For the Kintex-7 FPGA, add the following code:

LOC AD11 [ get_ports sys_clk n]
IOSTANDARD DIFF_SSTL15 [ get_ports sys_clk_n]
LOC AD12 [ get_ports sys_clk p]
IOSTANDARD DIFF_SSTL15 [ get_ports sys_clk_p]

set_property
set_property
set_property
set_property

set_property
set_property
set_property
set_property
set_property
set_property
#

# additional

LOC AB7 [ get_ports
IOSTANDARD LVCMOS15
LOC M19 [ get_ports
IOSTANDARD LVCMOS25
LOC K24 [ get_ports
IOSTANDARD LVCMOS25

constraints

sys_rst]

[ get_ports sys_rst]
RX]

[ get_ports RX]

TX]

[ get_ports TX]

#
create_clock -name sys_clk_pin -period "5.0"
# Added for RevC board

set_property slave_banks {32 34}

[get_ports "sys_clk_p"]

[get_iobanks 33]

Caution! If you have created an interface port for UARTIite, replace the following in the above code:
get_ports RX1t0 get_ports uart_rxd
get_ports TXt0 get_ports uart_txd

Save the file.

Mapping Addresses of Peripherals in an IP Integrator Design

1.

In the Project Manager, double-click the design name under Design Sources to open the
design.

Click the Address Editor tab.

w Navigator < | | Froject Manager - ipi_gsp!

X Sources

Q T et B[E -0 % || g Diagram
‘ﬂ\m
P s
log

Figure 59: Address Editor

Project Manager
5 Project settings
% Add Sources
4F Ip Catalog

5> Design Sources (1)
a

Js sys_gspl_ddr3_i - sys_gspl_ddr3 (sys_gspi_dcr3.b)
il BiE 0 e e | A ) U 1e | R
‘-)- 1 Constraints (1)

&= Simulation Sources (1)

IP Intearator

In the Address Editor, map any unmapped devices by doing the following:
a. Expand the MicroBlaze IP.
b. Right-click the Unmapped Slaves folder and select Auto Assign Address.

X | &P b X K| I (G Detau Layout ~ e K| ®
«| | Block Design  design_1*

Design Hierarchy — O 2 % || [ Address Editor x &< Diagram x
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TF mig_7series_1 (MIG 7 Series 1.8.a) =] | = | ¥ /microblaze_1
15 {it DDR3 i i Data
i s_ax1 o = axi_timer_1 Reg 0x41c00000 64K
& Init_callb_complete o == axi_uartlite_1 Reg 0x40600000 64K
» sys_rst o axiime.l Reg 0x41200000 64K
Foaulclk
e ek syne.rst m
Jesian = aresetn el
sslgn = sys.clkop L Jnan
= sys.clken | I Auta Assign Acdress |
2~ L.locw. mamery Export 10 Spreadsheet

tings - T
& Sources Bl Design Hierarchy
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Block Properties — o x|

+ +[E
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Figure 60: Auto Assign Memory Address to IPs

You can also change the address and range of the IPs.
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4. Change the Range of mig_7_series IP in both the Data and the Instruction section to 512
MB.

5. Save your design.

You must also ensure that the memory you are going to run and store your software from/in lies
in the cacheable address range specified by assigning values to the cache(s) base address
and cache(s) high address when you enabled Instruction Cache and Data Cache in
re-configuring MicroBlaze processor.

In order to use either mig DDR or AXI block RAM, they must be in the cacheable area or
MicroBlaze processor will not be able to read/write from them. Therefore your software won't
work if you place it in these memories.

[ Address Editor X e Diagram X

@, [Instance [Base Name Offset Address |Range |
AF Jricroblaze. 1
P Data
= axi.timer. 1 Reg 041600000
= = axi_uartiite.1 Reg 0x40600000
E = axiintc.l Reg 0x41200000
« Imb_bram_if_cntir_1 Memn 0x0
« axi_bram_ctrl_1 Memo 0XE0000000
= mig_7series_1 memaddr OxBOOO0OO00
¢ B Instruction
= |mb_bram_if_cntir 2 Mem 030
~mn axi_bram_ctrl 1 Memo OxcO000000
= mig_7series_1 memaddr OxBO000000

Figure 61: Assign Range to mig_7_series

You can also use this map to manually include or exclude IPs from the cacheable region or
otherwise specify their address.

Creating a Top-Level Verilog Wrapper
1. Go to the Project Manager.
2. Under Design Sources, right-click your design and click Create Top HDL.
A message notifies you that the block design file <design_name>.bd must be generated.
3. Click Yes.
The dialog box that opens asks you to generate output products.
4. Click OK.
Vivado creates a wrapper Verilog code for your design.

“low Navigator « Project Manager  project_2
3T Sources ENEREE | [T Project Summar
AT S |2 B B /projfipsjusers

1set_propert

@ Project Settings & @3 design_1_wrapper i 1 a 2set_proper!
¥ Add Sources - &, design_1_|

@ &® design.

= Constraints * Open File A0

& £7

¢ IP Intearatar b oo el

% 15 system.xd

i Create Block Desian o SimulaﬂnnSaurrI

1% Open Block Design

¢ Project Manager
© & Design Sources (1) |

3 Source Node Properties..,  CtrieE 4set_proper!
iF 1P Catalog Sset_propert
7 set_propert
Create Top HDL Esuu:r-npm-q
TETETIYE DT YT

Reset Qutput Products.

10 create_cloc
11

+ Simulation Hierarchy IF Sources Expart Hardware far SDK. g:::j: Z:::
. Package Block Design s
@ simulation Settings X\ Sources Ten L &l Hh
@4 Run simulation Source Node Properties 15set_proper!

16 set_proper!

£ Open Static Simulation | | g =

1 ot 1

rrianials % design. 1| - design_1| X Remove File from Project... Delete e

& Open Blaborated Desiat | nstance . | - —
+ Symthesis Module: Hierarchy Update G

@ synthesis Settings Location: & Refresh Hierarchy

P Run Synthesis Type: & P

B Open Symhesized Basig K1) Set File Type

General Attributes Set Used In

+ Implementation TR Edit Canstraints Sets

L] Setings | e ™Taaing compone] N 814, forz005 -

> Run Implementation 2 Adding componel Associate ELF Files ram_if_cntir:?

&% Open Implemented Des | — tffmg componel @ Add Sources Alt+A \-am:!fTEnE] r:‘i

Figure 62: Create Top HDL
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Reversing the Polarity of the Signal Coming to DDR Reset Input

Next, you must change the polarity of the sys_rst input that goes into the sys_rst port of
DDR. To do this, you must make a few modifications in the design_1_wrapper.v file

generated by the create top HDL function.

1. Double-click the top-level Verilog wrapper to open it.

This is created over the block diagram in the Design Sources tab, as shown in Figure 63.

2. Change the line
wire sys_rst

to

wire sys_rst_n;

3. After the line

7

assign DDR_odt[0] = \"DDR_odt

add the line

assign sys_rst_n = ~sys_rst ;

4. Change the line

.sys_rst(sys_rst);

to

.sys_rst(sys_rst_n);

5. Save the file and open the elaborated design

Note: This step is optional; it is to check if the code entered has inverted the signal coming to
sys_rst port. The Open Elaborated Design option is under the RTL Analysis header in the Flow

Navigator tab.

The system under the default layout has the input coming to the sys_rst port inverted, as
shown in Figure 63.

nnnnn

6. Run Synthesis.

28 %

<O DDR3_dq[63:0]

< DDR3_dqgs_n[7:0]

{O DDR3_dgs_p[7:0]

design_1_i
—LDRS . 2ddr13:0] ™5 DPR3_addr{13:0]
borsbazol S ppR3 bal2:0]
_|DDR3 cas n > DDR3_cas_n
DDR3_dq[63:0] _IDDR3 ck_n 5> DDR3_ck_n(0:0]
DDR3_dgs_n[7:0] DDR3_ck_p DDDRS_ck_p[O'O]
sys_clk_n LDRS dgsp7.0] —RDR3cke DDR3_cke[0:0]
s:s_clk_pg sys_clk.h DDR3_cs.n BDDRS_CS_N[O:O]
sys_rst_n_i sys-clh-pr —h b DDR3_dm[7:0]
sys_rst[ 2 o sys-rst DOR3_odt [ DDR3_odt[0:0]
RTL_INV uart-rdi —{pDR3.ras-n [ DDR3_ras_n
uart_rxd [> —IPDRS3_reset.n [> DDR3_reset_n
B DDR3. we.h [> DDR3_we_n
fuarttxd Suart_txd
design_1

Figure 63: Elaborated Design - Default Layout

7. Run Implementation.

8. Generate the Bitstream.
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Figure 64: Run Synthesis, Run Implementation, and Generate the Bitstream

Software Exporting the Design to SDK

Reference Next, open the design and export to SDK.

SVStem 1. Select File > Export > Export Hardware for SDK.

2. In the dialog box that opens, click to select the Launch SDK check box.

Hardware for SDK x|

0 Export harcware platform for SDK,

options
source: [ sys_mb_dara ba -]
Export to: ‘O‘ <Local to Project> . ‘
Workspae: [ <Local to Project> -]

& <Local to Project >
Choose Location

[ Export Ha| & None

[ ok | cancel

Figure 65: Select Workspace and Launch SDK

3. Specify the workspace to which you want to export your hardware design. If you don't
specify the workspace, your project will be exported to <project_name>.sdk/SDK/
SDK_Export/ by default.

4. Click OK.
SDK launches.
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Configuring FreeRTOS

1. In SDK, select Xilinx Tools > Repositories.

T C/C++ - Xilinx SDK (on xhdl-xhdcompl784)
Fle Edit Source Refactor Navigate Search Run Project [RISEE Window Help
o] o ® || e @ @ Tl Generate linker script
Wl Board Support Package Settings
(= Repositories |

L[ Project Explorer &2 =]

B % ¥ 2P Program EPGA
~ & hw_platform_0 A Program Flash

[ system.xml
» [3 XMD Console

[ Launch Shell

&} Configure JTAG Settings

¥ System Generator Co-Debug Settings
A create Zynq Boot Image

[2: Problems | & Tasks [ Console &2 [ Properties | & Terminal
C-Build [hw_platform_0]

Figure 66: Configure Repositories to be Used by Project

2. Click on New next to the local repository box to add a new local repository.

The freeRTOS repository is in the path <reference design path>/IPI_DDR_XAPP/
ipi_sys_ddr.sdk/sysrtos/lib.

3. Add the above path and re-scan the repositories.
4. Apply settings and click OK.

Creating a freeRTOS "Hello World" Application.

1. In SDK, right-click hw_platform_0 and select New > Project.

In the dialog box that opens, select Xilinx Tools > Application Project.
Click Next.

Type a name for your project and choose FreeRTOS as the OS platform.
Click Next.

ok~ DN

[z New Project (on xhdl-xhdcompl784) x|

Application Project —
Create a managed make application project /

Project namz' |

[/] Use default location

Target Hardware

Hardware Platform | hw_platrorm_0 =

Processor | migratiaza 2 =]

xilkernel

Target Software Tt

05 Platform standalone
Language @ C O C++

Board Support Package () Create New |app_bsp

@ [ <Back || mext> |[ cancer | [ fnish J

Figure 67: Select freeRTOS OS Platform and Name Your Project
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6.
7.

Select the freeRTOS Hello World application template.
Click Finish.
SDK creates a new Hello World application.

[l New Project (on xhdi-xhdcompl784) x|

Templates G :
Create one of the avallable templates to generate a fully- f /
functioning application project
Avallable Templates:

Dhrystone Let's say "Hello World' in FreeRTOS. |[*|
Empty Application

FreeRTOS Hello World

Hello W —————"""

Memory Tests

Peripheral Tests

SREC Bootioader

Xilkernel POSIX Threads Demo

@ [ <pBack | | cancel Enish |

Figure 68: freeRTOS Hello World Application Template

A working software project can be found at <reference design path>/IPI_DDR_XAPP/
ipi_sys_ddr.sdk/sysrtos/.

Executing the
System on a
KC705 Board

N —

To run the design on a KC705 board:

Connect the board to the local device.
Open Tera Term.

In the menu bar, go to Setup > Serial Port, select the COM port for your system, and set
the baud rate to 9600.

Unzip the reference design to a desired location and go to the project directory.
% cd <reference design path>/IPI_DDR_XAPP/

Start the xmd command line interpreter using the following command:

% xmd

Burn the Bitstream on the board using the fpga command:

% fpga -f ipi_sys_ddr/impl_1/sys_mb_ddr3_wrapper.bit
Start the MicroBlaze processor using one of the following commands:

connect mb mdm

%
% mbc

Reset and stop the MicroBlaze processor before actually running the software by using the
rst and stop commands, respectively.
Download the .elf file of the freeRTOS "Hello World" program.

% dow ipi_sys_ddr.sdk/sysrtos/app/Debug/app.elf

Note: The .elf is created by SDK and can be found in <reference design path>/
IPI_DDR_XAPP/ipi_sys_ddr.sdk/<path to your workspace>/<name of your
application project>/Debug/<name of your application project>.elf.

The working .elf file provided with this project can be found in <reference design
path>/ipi_sys_ddr.sdk/sysrtos/app/Debug/app.elf.

XAPP1162 (v1.0) January 10, 2013

www.Xxilinx.com 38


http://www.xilinx.com

References & XILINX.

10. Run the program using the run command.
% run

Note: The .bit and .elf files can also be found at the location <reference design path>/
IPI_DDR_XAPP/ready_for_download.

The output will be displayed in Tera Term. The expected output is shown below.

¥ COMS5:9600baud - Tera

e have demonstrated the thread scheduling on Free RIOS...
Enud Bye .

Figure 69: Expected Output

References The current versions of the following documents are referenced in this document:
1. DS768, LogiCORE IP AXI Interconnect Data Sheet

Additional Information

The design files for this document are located at
https://secure.xilinx.com/webreg/clickthrough.do?cid=201113.

The following documents provide additional information:

* UGB883, Kintex-7 FPGA KC705 Evaluation Kit Getting Started Guide
e UGO081, MicroBlaze Processor Reference Guide

e DS764, LogiCORE IP AXI Timer Data Sheet

» DS747, LogiCORE IP AXI INTC Data Sheet

* DS741, LogiCORE IP AXI UART Lite Data Sheet

e AMBA AXI4 specifications:
http://infocenter.arm.com/help/topic/com.arm.doc.set.amba/index.html#specs

e  FreeRTOS Porting Guide: http://www.freertos.org/FreeRTOS-porting-guide.html
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